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 Introduction to MPLAB and Harmony v3 for Atmel Studio

and ASF Users

Abstract
This document introduces the MPLAB® X IDE and MPLAB Harmony v3 framework for users to get started with new
tools and solutions for 32-bit Arm® microcontrollers. This document helps Atmel Studio, Atmel START, and ASF users
to familiarize with MPLAB X IDE and MPLAB Harmony v3.

This document also describes MPLAB X IDE features, MPLAB Harmony v3 architecture, and cite references to
equivalent features in Atmel Studio or ASF to enable better understanding.
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1. MPLAB X Integrated Development Environment (IDE)
MPLAB X IDE is a software tool that helps in developing embedded applications on Microchip's microcontrollers
(MCUs) and digital signal controllers. MPLAB X IDE can be installed on Windows, Linux and MAC operating systems.
This helps the user to continue the software development for an MCU without any operating system dependencies.

MPLAB X IDE comprises of the following:

• A full-featured programmer-friendly text editor.
• Utilities required for MCU firmware development, such as compiler, assembler, Linker.
• Debugger engine with a set of powerful debug utilities, such as breakpoints, watch windows, I/O views.
• A project manager that provides integration and communication between IDE and language tools.
• Software simulators.
• Plug-ins (to add to the capabilities of MPLAB X IDE), which can be installed and used.

MPLAB X IDE supports a wide range of Microchip’s 8-bit, 16-bit and 32-bit MCU portfolio. This document is specific
to 32-bit (Arm and PIC32) microcontrollers. To check a specific device for support, refer to the device support
documents listed in the section References of this document.

1.1 Installation and Toolchain
To install MPLAB X IDE, users need to download the appropriate installer from the Microchip website and follow the
prompts. MPLAB X IDE is a NetBeans-based platform.

The toolchains for MPLAB X IDE must be installed separately because it is not bundled with the MPLAB installer.
This provides flexibility to the user to install MPLAB XC8, MPLAB XC16 or MPLAB XC32-based compilers (or all the
three compilers).

MPLAB XC8 supports all 8-bit PIC® and AVR® MCUs. MPLAB XC16 supports all 16-bit PIC MCUs and dsPIC® Digital
Signal Controllers (DSCs). MPLAB XC32/32++ supports all 32-bit PIC and SAM MCUs.

Note:  The toolchain installation is handled differently in Atmel Studio. The Atmel Studio installer package is bundled
with toolchains for AVR, AVR32 and SAM devices, and users can select required toolchain while installing. Therefore
unlike Atmel Studio, users must install the MPLAB XC8, MPLAB X16, or MPLAB X32 compilers separately.

1.2 Licensing
The toolchain (MPLAB XC8, MPLAB X16, or MPLAB X32) comes with basic optimization features for code size and
speed. It also comes with a 60-day free trial license. If software development requiress advance-level of optimization,
then PRO licenses are available to unlock the full potential of the MPLAB XC C compilers. Refer to the list of flexible
licensing options available on the Microchip website.

Note: 
1. Atmel Studio comes with a standard Arm GNU C compiler for free.
2. Free C++ licensing is available in MPLAB X IDE.

1.3 MPLAB Pack Manager to Install Device Family Packs (DFPs)
The MPLAB Pack Manager can add or remove device support from MPLAB X IDE. A newer version of the DFP or
new device support can be added using the pack manager, hence no need to install MPLAB X IDE from scratch. This
eliminates the patching of MPLAB X IDE or smaller installer to patch few files.

To open the MPLAB Pack Manager, from MPLAB X IDE select Tools > Packs.

Note:  Atmel Studio handles the device part packs similarly.
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1.4 Key Features
The following are key features of the MPLAB X IDE:

• Multiple configurations for the same projects:
– A single project can build the same set of source files in various ways. Each configuration has its own

compiler options, hardware tool, and target device.
• Supports multiple versions of the same compiler.
• Intelligent text editor with the following features:

– Provides auto-completion
– Track changes within system using local history
– Users can configure required code format style

• Customizable workspace and multi screen support:
– Tasks window
– Navigator window
– Project Status window
– Software Call stack window

• Extend the MPLAB X IDE functionality with the MPLAB IDE Plug-in Manager.

1.5 Programming and Debugging Microcontrollers
The MPLAB X IDE supports Microchip’s various programming and debugging tools, which can be referenced from
the device-support documents listed in the section References.

The user can start debugging session in the MPLAB X IDE by choosing any one of these options:

• Clicking  (Debug Run) icon.
• From the toolbar, select Debug > Debug Main Project.

Note:  If multiple projects are opened in the MPLAB X IDE, the one which is set as the main project will be targeted
for the debug session.

During the debugging session, the following basic and advanced features required for debugging are available in the
MPLAB X IDE:

• Step Into, Step Over, Step Out, Run to cursor.
• Setting breakpoints.
• Hold in reset, Run.
• Viewing a variable in Watch window.
• Device peripheral register content in I/O view.
• Device’s memory content in Memory view.
• The Disassembly view of the code when instruction level debugging is needed.

Note:  Simulator support is available for few devices. Refer to the device support document for additional
information, which are listed in the section 7.  References.

1.6 MPLAB X IDE Plug-ins
Users can extend the functionality of the MPLAB X IDE by adding plug-ins. The user can select the functionality
based on their application requirement. Users might need advance features only based on their application
requirement; however, all users might not use Motor Bench Development Suite, RTOS Viewer, Power Monitor,
MPLAB Data Visualizer and so on, hence these are provided as plug-inS. Due to this the MPLAB X IDE can be kept
smaller in size, and it prevent users from loading the entire features set. This will reduce the memory and bandwidth
requirement in the PC which enhances user experience with the tool.
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Note:  The MPLAB X IDE plug-ins are comparable to the extensions in Atmel Studio.

1.7 MPLAB Harmony v3 Plug-in
The focus of this document is the MPLAB Harmony Configurator v3 plug-in which integrates the MPLAB Harmony v3
software development framework within the MPLAB X IDE.

Installing the MPLAB Harmony Configuration v3 plug-in adds the MPLAB Harmony Configurator (MHC) and MPLAB
Harmony Framework Downloader tool to the MPLAB X IDE. These tools can be launched from Tools > Embedded.
This framework downloader tool helps in cloning the MPLAB Harmony v3 repositories from the Microchip MPLAB
Harmony GitHub link. This document describes content delivery using the GitHub distribution and repository structure
in detail.

Note:  MPLAB Harmony v3 is a flexible, fully-integrated embedded software development framework for 32-bit
microcontrolles (MCUs) and microprocessors (MPUs).
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2. MPLAB Harmony v3 Software Development Framework
The MPLAB Harmony v3 architecture is discussed in detail in the following sections.

2.1 Introduction to MPLAB Harmony v3
MPLAB Harmony v3 together with the MPLAB X IDE, enhances the application development experience through the
simple and user-friendly peripheral libraries (PLIBs), abstracted drivers, and modular software downloads.

MPLAB Harmony v3 includes the MPLAB Harmony Configurator (MHC) tool, a set of modular device and middleware
libraries and numerous example applications, which are designed to help develop powerful and efficient embedded
software for Microchip’s 32-bit PIC and SAM microcontrollers.

The key features of MPLAB Harmony v3 are as follows:

• Unified software development framework for 32-bit PIC, SAM MCUs, and MPUs.
• MHC GUI tool to ease configuration of hardware components, for example, Clock, Pin, Interrupt, ADC, DMA,

Memory Protection Unit (MPU).
• Framework downloader to simplify the process of downloading the firmware libraries, demonstration

applications, and extensions to the MHC GUI.
• Simple, light weight, and user-friendly peripheral libraries (PLIBs).
• Modular and interoperable drivers and system services.
• Rich set of middleware.
• Support for RTOS and other third-party libraries.
• Flexible firmware design models.

MPLAB Harmony v3 has a layered architecture that consists of several software modules. These modules are
portable, compatible to each other and they communicate and exchange data and information with each other. The
figure below illustrates the MPLAB Harmony architecture.

Figure 2-1. MPLAB Harmony Architecture

• PLIB: This layer is the closest to the hardware with no abstraction and direct register access.
• Driver: This layer is the software peripheral drivers written on top of the PLIBs.

 AN3346
MPLAB Harmony v3 Software Development ...

© 2020 Microchip Technology Inc.  DS00003346A-page 7



Note:  The term driver has a different meaning in MPLAB Harmony v3, ASFv3 and Atmel START. A MPLAB
Harmony v3 driver is rich in nature and abstracted from the hardware, whereas ASFv3 driver has a little
software handling and complete hardware access. Atmel START drivers are divided into HAL, HPL, and HRI
layers.

• System Configuration: The system service manages shared system resources. These resources can be used by
drivers, middleware or applications, such as Timer service, debug console, Clock, and DMA configurations.

• Middleware: Middleware typically consists of softwares that involves using protocols (sometimes related to
IEEE® standards) such as, USB software stack, TCP/IP network stack, Graphics stack, Bluetooth, and other
Wireless stacks.

• Third-party libraries: Consists of few RTOS options, Graphics stack from Segger, Secure Socket Layer (SSL),
Transport Layer Security (TLS), and Cryptographic libraries from WolfSSL Inc®.

• Plug-in: Custom Bluetooth Profiles or USB function classes are available as plug-ins. For example, the USB
protocol stack is a plug-in.

• MHC: A GUI tool used to configure the MPLAB Harmony v3 projects and generate codes. Users can configure
the clock, pins, peripherals and so on to fit the needs of their application and generate the code. Then PLIBs
and driver content might change according to the configuration. The code rendering or code generation is part of
the MHC, and is used to maintain the drivers, and to avoid unwanted code.

2.2 Modular Downloads and Repository Structure
Microchip maintains a repository on GitHub that provides a catalog of MPLAB Harmony v3 repositories. The MHC
download manager will read this catalog and download the library packages (and other content) selected by the user.
The MHC clones them locally to make them available for including in the projects.

The distribution of the MPLAB Harmony v3 software framework over GitHub has advantages over the typical
installer-based content delivery. Installer or zip file-based content delivery will install a full set of framework source
files every time the installer is run. Git will update only the changes made to each file, which simplifies content
delivery and reduces the bandwidth required to install numerous files every time.

Note:  Users must be aware which repositories are required for their application. Knowing the repository structure
will help the user to understand their requirement.

The following are MPLAB Harmony v3 repositories:

• bootloader
• wolfSSL
• wolfSSH
• touch
• USB
• Crypto
• core
• bsp (board support package)
• csp (chip support package)
• dev_packs
• wolfMOTT
• mhc
• smartenergy_plc
• motor_control
• gfx_apps
• gfx
• audio
• bt
• net
• at91bootstrap
• micrium_ucos3
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• CMSIS-FreeRTOS (From Arm GitHub)

The following repositories are required to start the MPLAB Harmony v3 framework.

• dev_packs repository: Contains the ATDF files (specific to each device), device header files, and peripheral
header files which will be used during the code generation. An ATDF file has XML tags and information related
to the device hardware. The MHC uses the information from the ATDF files to generate valid code at the
hardware level.

• Chip Support Package (csp) repository: Contains peripheral libraries (PLIBs), and application demonstrations
that use the PLIBs for all peripherals supported. The PLIBs are written such a way that it communicates with the
hardware without any abstraction. The csp repository has the following structure:

– apps/: This folder has PLIB demonstrations for almost all the peripherals in all the devices supported in
MPLAB Harmony v3. Each peripheral can have multiple PLIB demonstrations.

– peripheral/: This folder has PLIB for almost all the peripherals in all the devices supported in MPLAB
Harmony v3.

– arch/: This folder has software logic for device support based on the MCU architecture. MPLAB Harmony
v3 supports Arm Cortex M0+, M4, M7, Cortex A5, and MIPS architecture-based devices.

– doc/ or docs/: These folders have the help documents for PLIBs and PLIB demonstrations

Tip:  In the csp repository and the apps folder, the folder names are the same as the peripheral names in
the data sheet. For example, general purpose I/O ports are named differently in different device families.
Some devices have an I/O peripheral named GPIO, and in other devices it is PIO or PORT. Therefore, the
csp and apps folders have three different folders called GPIO, PIO and PORT. Check the device data
sheet and navigate to the folder according to the peripheral naming in the data sheet. This will help
identifying the right demonstration for a peripheral.

• Core repository: This repository contains drivers and services with user-friendly abstractions of peripherals and
shared resources based on which middleware and applications are developed. Drivers and services provide
advanced capabilities, such as buffer queuing and peripheral sharing. The core repository also provides an
Operating System Abstraction Layer (OSAL). MPLAB Harmony v3 supports multiple third party real-time
operating systems (RTOS). Harmony drivers, services, and middleware use RTOS-specific methods to ensure a
thread safe operation and RTOS compatibility. To use RTOS-specific methods, Harmony libraries have to call
different functions for each supported RTOS. To do this, MPLAB Harmony v3 defines an Operating System
Abstraction Layer (OSAL). The OSAL is a lightweight OS compatibility layer that abstracts away the RTOS-
specific details and provides a consistent set of functions that the MPLAB Harmony libraries may call to obtain
the RTOS-specific capabilities they need to protect shared resources.
The core repository has the following structure.

• apps/: This folder has examples for core components like drivers (I2C, SPI, USART etc.,), file system,
FreeRTOS and system timer service.

• driver/: This folder has MPLAB Harmony v3 drivers for I2C, USART, SPI, SDMMC, SDSPI, Memory. These
drivers are built on top of PLIBs.

• osal/: This folder has a wrapper layer on top of the RTOS that are supported.
• system/ : This folder has system services, such as DMA, Virtual File system, Interrupts, I/O Ports, Debug

console, command console, Timers, and Random number.
• doc/ or docs/: These folders have the help documents for core components and demonstrations.

• Board Support Package (bsp) repository: The bsp repository contains board specific information. This includes
I/O pin details, such as LEDs and switches on the board connected to the I/Os.

2.3 Flexible Firmware Design Models
The MPLAB Harmony v3 architecture allows implementing a variety of applications from small real-time applications
to larger feature rich applications.

The following design models are supported by MPLAB Harmony v3:

• Simple device configuration and initialization using MHC
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• Peripheral library-based projects
• Powerful, conflict-free driver-based projects
• Projects requiring MPLAB Harmony middleware
• RTOS-based projects for optimum Central Processing Unit (CPU) utilization

MPLAB Harmony v3 libraries are provided in packages, and maintained in GIT repositories on GitHub. The MPLAB
Harmony v3 Chip Support Package (CSP) supports simple device initialization and PLIB-based projects, relying only
on the appropriate Device Family Pack (DFP), and standard ‘C’ libraries and tools. It has no external module or
component dependencies. Advanced projects that require abstraction from the hardware, operating system support,
or powerful middleware capabilities will rely on the MPLAB Harmony v3 core package.

Figure 2-2. MPLAB Harmony v3 Libraries

Harmony CSP, Core, & Middleware

Harmony Core & Middleware PackagesChip Support Package (CSP)

PLIB‐based & minimal configuration applications 
are supported by the CSP module (plus device 
pack support).

Harmony driver, service, middleware, and RTOS‐
based applications require Harmony core and 
other modules.

Simple 
Projects

Advanced 
Capabilities

2.4 Advanced Software Framework v3 and Atmel START Architecture
Atmel START (ASFv3): The Advanced Software Framework (ASF) provides software drivers and libraries to build
applications for Atmel megaAVR®, AVR XMEGA®, AVR UC3 and SAM devices. ASF is designed to help develop and
bring together the different components of software design.

The ASF folder is divided into six sub-folders based on family of devices. The following list displays the contents of
the ASF root folder:

• avr32/
• common/
• mega/
• sam/
• thirdparty/
• xmega/

Each architecture folder and the common directory are divided into several sub-directories, these directories contain
various modules, boards, drivers, components, services and utilities. The following sub directories provides an
overview of how the various modules are wired together.
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• applications/
• boards/
• components/
• drivers/
• services/
• utils/

Atmel START (ASFv4): This is the next generation of ASF built to work as a web-based user interface with GUI for
the ease of configuration and usability. ASFv4 represents a complete redesign and implementation of the whole
framework when compared with ASFv3. The redesign is made by making a significant change in architecture. The
drivers are made as use-case drivers and the folder structure is modified to fit this new architecture. The driver layer
is divided into Hardware Abstraction Layer (HAL), Hardware Proxy layer (HPL), and Hardware Register Interface
(HRI) layer. HAL remains common across devices, and HPL and HRI vary according to the hardware used.

Figure 2-3. MPLAB Harmony v3, ASF3, ASF4 and Atmel START Architecture Overview

SAM

ASF3 ASF4

CMSIS/DFP

Driver

[Services]

Application

CMSIS/DFP

HRI

HPL

[Abstract 
Device]

HAL

[Simple 
I/O]

[Middleware]

Application

PIC32M, SAM

Harmony 3 / MHC 3

CMSIS/DFP

PLIB

[Driver]

Application

[Middleware]=

≈

≠

[Driver] ==  optional

[Middleware] ==  optional

Table 2-1. MPLAB Harmony v3, ASFv3 and Atmel START Architecture Information

Harmony v3 Atmel START ASF v3

Configuration specific code
generation Yes Yes No

Can get Standalone project Yes No (Uses native header
files from Atmel Studio) Yes

GUI Aided Tool Yes Yes No
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...........continued
Harmony v3 Atmel START ASF v3

Other Toolchain support Yes (IAR) Yes (IAR, Keil makefile) Yes (IAR)

Modular download Yes (GitHub-based) Yes (Individual project) No

Cloud based Tool No Yes No

Integrated with IDE Yes (MPLAB) Yes (Atmel Studio) Yes (Atmel Studio)

Framework available as
standalone zip No No Yes

Content Distribution GitHub repository (to be
cloned locally) Cloud Part of Atmel Studio

Installation

Peripheral Driver model Peripheral Configuration
specific (plibs) Use-case specific Full generic driver

Business logic available Yes No No

Native Compiler support XC32 compiler GCC GCC

2.5 Significance of Peripheral Libraries (PLIBs) in MPLAB Harmony v3
This is the lowest level interface to the peripherals of a device. This is named as a library, but it consists of source
(.c) and header (.h) files. Typically, each peripheral instance has a source and header file associated with it. The
Application Program Interface (API) implementation is kept simple, such that the most of it will be direct peripheral
register access.

Most API names and structures are consistent across devices which helps in driver portability. Typically, driver layers
use PLIB API calls. Therefore, PLIBs are closely associated with peripherals, and these vary from device-to-device.
Most PLIBs can be used either in polled mode or in interrupt mode. To realize polled mode, PLIBs have blocking
calls. Interrupt mode supports ISR functionality with call-back support. There is no error checking, sanity checks, or
state maintenance in a PLIB. The PLIB has clean code and no conditional macros (#if, #elif.) for readability.

Table 2-2. Example of Basic PLIB APIs Availability

Usage UART SPI I2C/TWI

Initialization UARTx_Initialize() SPIx_Initialize() TWIx_Initialize()

Transaction

UARTx_Write() SPIx_Write() TWIx_Write()

UARTx_Read() SPIx_Read() TWIx_Read()

- SPIx_WriteRead() TWIx_WriteRead()

Status
UARTx_ReadIsBusy()

SPIx_IsBusy() TWIx_IsBusy()
UARTx_WriteIsBusy()

2.6 Advantages of Harmony Drivers
The MPLAB Harmony drivers provide an abstracted interface to access the hardware. This enabless portability of the
applications and middleware across platforms. This is the preferred method to access peripherals when the software
needs to be ported across hardware platforms.

The following are key features of the MPLAB Harmony drivers:

Multi-Client Operations
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Figure 2-4. Multi-Client Operations

I2C‐1

Sensor EEPROM

Application
(Client 1)

Application
(Client 2)

Harmony Driver
(I2C)
Driver 

Instance 0

Client-1 Config Client-2 Config

When two different clients in an application access the same instance of a peripheral, the driver must be capable of
accessing the correct sensor to give data to the correct client. The MPLAB Harmony v3 driver is capable of handling
this multi-client scenario.

Multi-Instance Operation

In a Multi-Instance scenario, the same driver (code) is capable of handling many instances of a peripheral.
Application clients can call the same driver function to perform the job with the respective peripheral instance.
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Figure 2-5. Multi-Instance Operation

I2C‐1 I2C‐2

Sensor EEPROM

Application
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Application
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Driver 
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Driver 
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• Same API for all the instances of a peripheral:
– Application remains same when the peripheral instance is changed

I2C Driver API I2C PLIB API

DRV_I2C_WriteTransferAdd(...) I2C1_Write(…)

I2C2_Write(…)

DRV_I2C_ReadTransferAdd(...) I2C1_Read(…)

I2C2_Read(…)

• Support for DMA Transfer mode - Driver Interface or API remains same with or without DMA Transfer mode
• Buffer/Queue Support
• Error checking
• Sanity checks
• RTOS ready
• Thread safe

Drivers will not use blocking APIs. Both sync and async driver types are available in MPLAB Harmony v3.

Harmony v3 Drivers:

There are two MPLAB Harmony v3 drivers, Asynchronous (async) and Synchronous (sync). The driver details are as
follows:

• Asynchronous (async)
– Non-blocking APIs
– Works seamlessly in bare-metal and RTOS environment
– Interrupt and Thread safe
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• Synchronous (sync)
– Blocking APIs
– Suitable for use in RTOS environment
– Interrupt and Thread safe

Note:  The term sync and async in MPLAB Harmony v3 have a different meaning than in Atmel START. In Atmel
START, available driver types are sync, async and RTOS. sync means polled driver, async means interrupt based,
and RTOS driver is an RTOS compliant driver.

2.7 Middleware Support
MPLAB Harmony v3 middleware provides sophisticated software libraries that support key technologies, such as
industry-leading graphics, TCP/IP networking with broad protocol support, USB Host and Device capabilities for the
most commonly used device classes, cryptographic capabilities, and so on. These software libraries are built upon
MPLAB Harmony v3 drivers and services, hence the middleware works with all supported Microchip 32-bit devices,
while still allowing direct access for peripherals that are not used by the MPLAB Harmony libraries.

Figure 2-6. Supported Middleware

Middleware

• Wi‐Fi
• wolfSSL
• TLS
• Crypto
• DSP
• Boot

• BT/BLE Data, A2DP, Voice,…
• Audio Encoders, Decoders, MFi,…
• Multi‐lingual GUI Support
• File Systems: FATFS, MPFS
• Flash Media: NVM, SQI, SPI, 

SD Card, USB Stick
• Touch: Screen, Capacitive Button

Math
• Basic
• Fast
• Complex
• Filtering
• Matrix
• Transforms

Note:  Supported middleware details are provided in the section References.

2.8 Operating Systems Abstraction Layer
MPLAB Harmony v3 supports multiple RTOS. Each RTOS has its own API call to create tasks, run the scheduler,
semaphore, or mutex handling. To enable the compatibility of MPLAB Harmony v3 drivers in a non-RTOS
environment (BareMetal) and across various RTOSs, MPLAB Harmony v3 provides an abstraction layer known as
Operating Systems Abstraction Layer (OSAL). OSAL supports a minimal feature set that was abstracted from many
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different RTOS products for maximum compatibility. The focus of the OSAL is providing the minimum set of
mechanisms necessary for safe operation of libraries in a multi threaded environment.

Primary OSAL Features

The OSAL features are as follows:

• Mutexes: Used to manage the ownership of resources, hence can only be accessed exclusively by a single
thread at a time.

• Semaphores: Primarily used to synchronize between different threads.
• Critical sections: Used to protect a section of code, thus it must be executed atomically (uninterrupted or

indivisibly).
• Memory allocation: Used to support RTOS-specific memory management (Abstracts malloc and free if no

RTOS-specific memory management).
• Initialization and Information: OSAL support and OS information.

Figure 2-7. OSAL and RTOS Mapping

Driver Function
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OSAL_SEM_Pend()

OSAL_SEM_Pend

Express Logic - ThreadX

tx_semaphore_get()
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OSSemPend()

FreeRTOS/OPENRTOS

xSemaphoreTake()

OSAL call maps 
(statically) to API of 
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project.

Driver Function

Call returns when resource 
is available, letting driver 
function resume.

Driver call will block, if 
resource not immediately 
available.

Time

 AN3346
MPLAB Harmony v3 Software Development ...

© 2020 Microchip Technology Inc.  DS00003346A-page 16



3. MPLAB Harmony v3 GitHub Repository Handling
MPLAB Harmony v3 must be used with MPLAB X IDE. After Installing MPLAB X IDE, the MPLAB Harmony
Configurator v3 plug-in must be installed. After the plug-in is installed, the MPLAB Harmony 3 Content Manager and
the MPLAB Harmony 3 configurator are available to use.

A significant change is that MPLAB Harmony v3 content is now delivered through GitHub. The MPLAB Harmony 3
Content Manager helps in cloning the public GitHub repositories to a PC. The user can select which repositories to
be cloned. Once the repositories are cloned, the user can update them regularly to keep the content synchronized
with the master branch on the cloud.

3.1 Downloading Packages Using MPLAB Harmony 3 Content Manager
Using MPLAB Harmony 3 Content Manager, users can download packages in the MPLAB X IDE. Follow these steps
to download packages:

1. After the MPLAB Harmony Configurator 3 plug-in is installed, launch MPLAB X IDE.
2. Select Tools > MPLAB Harmony 3 Content Manager. The MPLAB Harmony Content Manager Window will be

displayed. This Window has the following two tabs:
2.1. Content Manager - Helps in downloading and updating MPLAB Harmony repositories from Remote

GitHub. Users can download selected repositories from GitHub.
2.2. Application Browser - Helps in downloading Application Demo Projects available in all available

repositories. Users can download selected example projects.
Figure 3-1. MPLAB Harmony 3 Content Manager

3. While opening the MPLAB Harmony 3 Content Manager, specify a path to clone framework repositories.
Note:  First time, MPLAB Harmony 3 Content Manager will list all the available repositories in the public
GitHub link. The user can select the required repositories and then click Download to clone the selected
repositories to the PC. Thereafter, MPLAB Harmony 3 Content Manager will list if any new repositories added
by Microchip. If needed, the user can select the newly added repositories to download.

3.2 Updating the Repositories Using MPLAB Harmony 3 Content Manager
If a repository is downloaded, the MPLAB Harmony 3 Content Manager will query the tag information of the branch
on the PC and what is available on the Web. If the Web has a newer version, the user can update the appropriate
repository.

If the user has modified a repository, such as changing a configuration, then the user can clean the repository using
the MPLAB Harmony 3 Content Manager and update the repository.

 AN3346
MPLAB Harmony v3 GitHub Repository Handlin...

© 2020 Microchip Technology Inc.  DS00003346A-page 17



Figure 3-2. Updating Repositories

Tip:  As internet link strength and server response speed vary, hence this step might take some time.
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4. Integration Between MPLAB X IDE and MPLAB Harmony v3
The MPLAB Harmony v3 framework configurator will launch the MPLAB Harmony v3 framework development
environment.

4.1 MPLAB Harmony v3 User Interface
One of the significant features of MPLAB Harmony v3 is the graphical user interface (GUI) which helps to configure
the MCU features easily. The following list provides examples of some of the GUI windows under the MHC GUI:

• Project Graph
• Clock Manager
• Pin Manager
• NVIC Manager
• DMAC manager
• ADC manager
• PTC Manager
• Motor-bench Suite

The Project Graph shows all the modules used in the project, and their connection with other modules to give a visual
representation of dependency between the modules. Similarly, other GUI windows are very helpful in configuring the
corresponding modules.

Configuring these modules is possible without using these easy-to-use GUIs. This can be done by using the other
basic UI configuration tree. When using the UI configuration trees, the user needs to pay more attention to
understand the hardware and configure it correctly in the tree view.

For example, many SAM devices have lot of flexibility in clock configurations. If the user had to configure the clock
without the Clock Manager, the user should fully understand the clock distribution of the MCU, and configure the
clock using the UI configuration tree.

The Clock Manager GUI in the MHC, helps by visually showing the clock tree, status and values on the UI which is
similar to the clock distribution diagram available in the data sheet. Therefore, the user can configure them easily.
The Clock Manager shows the CPU, other clock values, and the Clock mask status. If there is any change in clock
masks, DPLL ratio, or prescalars, the Clock Manager updates the corresponding values for the clock and status
accordingly and shows the current values.
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Figure 4-1. Clock Manager (MHC > Tools > Clock Configuration)

Other GUIs, such as the Pin manager, NVIC Manager, and ADC manager ease the configuration.

Note:  Atmel START has similar GUIs for the clock, pinmux, and Qtouch. Users familiar with the GUIs in Atmel
START will find the Harmony v3 GUIs user friendly. In addition, MPLAB Harmony v3 has more GUIs, such as the
DMAC, NVIC, and Event system manager to ease the configuration of a peripheral.

4.2 MPLAB Harmony v3 – Exploring a PLIB Demonstration Project
After installing MPLAB X IDE and MPLAB Harmony v3 configurator, the user can open any one of the PLIB or core
demonstration example MPLAB Harmony v3 projects.

To start with a simple project, an example PLIB demonstration project is explored. This sub-section will help the user
to open a PLIB demonstration, use the MHC, and explore project windows to gain familiarity with the programs.

1. Launch MPLAB X IDE.
2. From the toolbar, select File > Open Project .
3. Go to the Path where the csp repository is downloaded.
4. Go to apps.
5. In the apps folder, select an example peripheral: from port > port_led_on_off_polling > firmware > select

project for any board of user’s choice.

Before this step, only the MPLAB Harmony v3 project is opened and not the MPLAB Harmony Configurator. After
opening a MPLAB Harmony 3 project, Go to MPLAB X IDE > Tools > Embedded > MPLAB Harmony configurator.
The following figure shows the MPLAB Harmony v3 project opened along with the MPLAB Harmony Configurator
(MHC) in MPLAB X IDE.
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Figure 4-2. Project Window When MHC Opens
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4.3 Harmony v3 Project Folder Structure
The following figure displays the structure of a PLIB project in MPLAB Harmony v3.

Figure 4-3. MPLAB Harmony v3 PLIB Project Folder Structure

Exceptions
 Implements all exception handlers

Initialization
 Initializes the system and peripheral libraries

Interrupt Vectors
 Contains the interrupt vector table

System prototypes and definitions
 Includes all library headers and 

definitions needed for the system

Peripheral Libraries
 Contains the peripheral logic

Startup 
 Contains the C startup code

Device Family Pack (DFP)
 Provided by Microchip. Product specific

information

CMSIS
 Provided by ARM. Core specific information.
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4.4 Compiling, Programming and Debugging a PLIB Demonstration Project
The opened PLIB demonstration project can be compiled and programmed as is. All PLIB demonstrations available
in the repository should be compiled as is, with no need for regenerating the project. To compile and program a PLIB
demonstration, the user must select the DFP, compiler toolchain, and hardware tool (the tool must be connected to
the PC) to be used with this project.

1. Right-click on the project and select properties.
2. In the Project Properties window, under Categories select Conf (sam_v71).
3. In the Configuration section, select the DFP, Hardware tool, and compiler toolchain version (if multiple versions

are installed) to compile and program the project in the device.
Figure 4-4. Project Properties

The following options can be changed in the Project Properties window:

– General File Inclusion, File Exclusion, MACRO addition
– XC32 compiler settings, such as optimization, preprocessing settings, message settings, and additional

optional compiler switches
– General linker settings, linker symbols and macros and linker switches
– XC32 assembler options
– Debugger program options, memories to program, debug communication interface speed

4. Click the  (Make and Program Device) button to compile the project and program the device with
compiler code.

5. To start the debug session, from the MPLAB X IDE, select Debug > Debug Main project, or click 
button . This enables the user to debug the project.

4.5 Modifying Components, Configurations and Regenerating Code for the PLIB
Demonstration
To modify or change a peripheral in the project graph, the user must open the MPLAB Harmony Configurator first.
Once the Harmony configurator is opened, the user can add or remove any peripheral to the project graph. In the

 AN3346
Integration Between MPLAB X IDE and MPLAB ...

© 2020 Microchip Technology Inc.  DS00003346A-page 22



Tree view, change the configuration of the included peripherals per the needs of the application and regenerate the
code.

To regenerate the code for the new configuration, click the  (Generate Code Icon) or go to MHC >
Generate Code. Before regenerating the new code, the MHC shows the files with the changes that are going to be
done (line wise) as the result of the re-configuration. The user can accept or reject the changes (line wise) based on
the result.

Figure 4-5. Line Wise Change

Note:  This option is useful to view the changes made by the MHC to each file.

Tip:  To enable this option, change the following settings in the MPLAB X IDE:
While regenerating the code, the merge window appears with the option USER_ALL. Change this to ALL.
USER_ALL causes the changes to the Harmony 3 framework files to be done without prompting the user.
ALL means the changes are prompted for all files including the Harmony 3 framework files.
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Figure 4-6. Merge Strategy from USER_ALL to ALL

4.6 Harmony v3 Services - Standard I/O (STDIO), Toolchain Supports
Harmony v3 has support for Standard I/O (STDIO). Users can use the standard printf and scanf through the
USART module in the hardware using STDIO module.

Similarly, users who are using IAR IDE, can make use of generating the project for the IAR toolchain. In Project graph
> System module the device and project configuration settings for the Toolchain are available. XC32 and IAR is
currently available.
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Figure 4-7. Toolchain Selection

When selecting the IAR toolchain, the ipcf file will be generated along with the project files.

Note:  Users familiar with the IAR IDE support in Atmel START will find this easy to use, because the Atmel START
also uses same ipcf file for extending the support to the IAR IDE. Ipcf is a project connection file which is the
standard method used by IAR to generate the project from other platforms.
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5. Example Applications

5.1 Example Demonstrations Available in Harmony v3
The apps folder in the csp and core repositories contains example applications for peripherals. The apps folder is
organized by peripheral. Each peripheral has a folder associated with it, and all examples for the peripheral are
available within the folder. Each peripheral may have multiple example projects to explore.

PLIB based example projects are available in csp repository. The following path describes the location of the PLIB
example projects.

RTC example: csp > apps > rtc > rtc_periodic_timeout > firmware > select project for the appropriate board.

SPI example: csp > apps > spi > spi_eeprom_write_read > firmware > select project for the appropriate board.

DRIVER based example projects are available in the core repository. Specific example projects for async and sync
driver types are also available. The following path describes the location of the DRIVER example projects.

I2C example: core > apps > driver > i2c > async > i2c_eeprom > firmware > select project for the appropriate board.

I2C example: core > apps > driver > usart > sync > usart_echo > firmware > select project for the appropriate board.

Note:  ASFv3 contains example projects for the peripherals that are similar to Harmony v3. Atmel START is a web-
based tool and example projects are listed separately in it. Examples can be downloaded from the Atmel START
website.

5.2 Creating a Simple Application Demonstration Using Harmony v3
This section provides a brief overview on creating a simple PLIB demonstration. For step-by-step migration details,
refer to these documents :

• ASF3 to MPLAB Harmony 3 Migration Guide
• Atmel START to MPLAB Harmony 3 Migration Guide

The following steps contain high-level information for creating an application demonstration in MPLAB Harmony v3:

1. Launch MPLAB X IDE, and then select New Project > 32-bit MPLAB Harmony 3 Project.
2. Framework selection: Give the root location of the MPLAB Harmony 3 Folder.
3. Project settings: State the location and name for the project.
4. Configuration settings: State the name for the configuration.
5. Select the right device to be used.
6. Configuration database setup: Select the MPLAB Harmony repositories to be loaded for the project.
7. The MPLAB Harmony project will be opened along with the MPLAB Harmony configurator. By default, the

project graph will be opened in which a few modules are added to the Project.
8. Add, connect, and configure the modules. The user can add peripherals required for the application. Connect

them in the project graph and configure them in the UI tree per the application requirement.
9. After adding and configuring the modules, regenerate the code along with main and application source files.
10. The user can write application logic and implement the application functionality.
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6. Appendix

6.1 Establishing Connection with Target Hardware Using MPLAB IDE
In Atmel Studio, one of the most used windows is Device Programming. In MPLAB X IDE, these functions are done
using another application called MPLAB Integrated Programming Environment (IPE). This application is installed
along with MPLAB X IDE. When needed, this application can be launched and used to ensure that the connection
between the target and the debugger is established correctly.

Users can use this IPE to erase the chip, read or write the HEX files to the chip, and verify the content with
application image available.

Fuse programming: In Atmel Studio, fuses are programmed separately but this is handled differently in MPLAB X
IDE. MPLAB X IDE allows the user to view and generate the code (For fuse configuration) which the user can copy in
the source file. MPLAB X IDE programs both the application image and the fuses at the same time.

Launch MPLAB X IDE > Windows > Target Memory Views > Configuration Bits

6.2 Basic Understanding of GIT
MPLAB Harmony v3 contents are delivered through GitHub. If users are new to GIT, it is good to have some basic
understanding of what GIT is and how it works. GIT is different from other version control systems. It is a distributed
version control system and not a centralized version control system. It saves the data lot differently than SVN does.
Refer to the section References for information on GIT basics.

6.3 Import Atmel START Project into MPLAB X IDE
Follow these steps to import the Atmel START project into the MPLAB X IDE:

1. Open the MPLAB X IDE.
2. Select file > Import > START MPLAB Project.
3. Upload the .atzip file using the Browse option.
4. Ensure that the correct device has been selected, choose the programming tool.
5. Select the compiler toolchain as Arm.
6. Specify the location of the project and verify all the information is accurate.

6.4 Adding Custom Linker Script to MPLAB Harmony v3 Project
The MPLAB Harmony v3 Project uses a default linker script that comes with MPLAB X IDE installation. A few projects
might need custom linker scripts. The MPLAB Harmony v3 supports adding custom linker scripts to a project. Use the
following steps to include the correct linker script in the project:

1. Right-click on the Linker Files folder in project > Add Existing item > select specific linker script which needs to
be linked.

2. Project Properties > XC32 global options > xc32-ld > Additional options > add linker switch to use this linker
file for linking. [-T ..\..\..\yy\xxxx.ld]

6.5 Modifying the PLIB and Maintaining it While Regenerating the Code
There are some rare use cases where a specific feature or minor modification needs to be done in a PLIB (for
example, API addition). In those cases, the user can modify the PLIB as needed. After the manual PLIB change, the
user can change the PLIB configuration. While regenerating the code after this change, the PLIB will be changed
according to the new configuration.
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The user can maintain their manual change and allow only the configuration changes which are updated in the plibs.
In order to do this, when the merge window appears, change the option USER_ALL to ALL. USER_ALL means
changes to the MPLAB Harmony 3 framework files will be done without prompting the user. ALL means the changes
are prompted for all files including the MPLAB Harmony 3 framework files.

Figure 6-1. Keeping Custom Changes in PLIB while Regenerating Code
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The Microchip Website
Microchip provides online support via our website at http://www.microchip.com/. This website is used to make files
and information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to http://www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: http://www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is one of the most secure families of its kind on the market today,

when used in the intended manner and under normal conditions.
• There are dishonest and possibly illegal methods used to breach the code protection feature. All of these

methods, to our knowledge, require using the Microchip products in a manner outside the operating
specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of
intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.
• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code

protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection
features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital
Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you
may have a right to sue for relief under that Act.

Legal Notice
Information contained in this publication regarding device applications and the like is provided only for your
convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with
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indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such
use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless
otherwise stated.
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